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(1) Who should have this book?
This book was designed to be a quick-access 
handbook, mainly for working designers and 
artists, but that doesn’t mean that photogra-
phers or even hobbyists can’t get something 
out of these pages either. Whether you need 
quick instruction or even just a little inspira-
tion, this book is for you!

(2)  What is the user level of  
this book?

This book assumes an intermediate or 
higher-level user—especially later in the 
book when you get to the Hollywood-style 
and 3D chapters. But, that does not mean 
it excludes beginners. The exercises are 
easy to follow along with for newbies, if 
you are patient with the steps, but it helps 
to at least have a good foundation of how 
Photoshop works.

(3)  What about the fonts used  
in this book?

The fonts used in this book, in many cases, 
are the default fonts that are part of your 
OS. However, quite a few are from Adobe 
Typekit, which is a font service that is part 
of Adobe’s Creative Cloud and allows you 
to sync fonts to your desktop applications. 
This service is only available to full Creative 
Cloud subscribers.

(4)  What version of Photoshop  
do I need for this book?

The exercises in this book were created in 
Photoshop CC 2015. If you are using an 
older version of Photoshop, I first have to 
ask, why? I am kidding. Though, seriously, a 
lot of the techniques within this book can be 
done in some older versions of Photoshop, 
but if you are a Creative Cloud subscriber, 
you should have the newest version anyway.

(5) What about exercise downloads?
You can follow along with the projects by 
downloading low-res versions of the same 
image files used in the book. This way 
you can make sure you understand the 
techniques, so you can then apply them 
to your own projects. You can download 
these files over at kelbyone.com/books 
/psdesignbook.

Seven Questions & Answers About This Book



ixPhotoshop Tricks for Designers

(6)  How about the use of  
stock images?

While in some cases I use images I have 
shot with my camera or my phone, I have 
always been a big proponent of using stock 
images. Throughout this book, I utilize a lot 
of stock images from Adobe Stock (former-
ly Fotolia.com). This is a fantastic resource 
and the best part is that it is built right into 
the Creative Cloud, though it is a separately 
priced service. When you sign up, you get 
10 free images, and you can download wa-
termarked comps of any image. 

(7) What about other resources?
In addition to Adobe Stock, there are a few 
other resources I use that I wanted you to 
be aware of. While these are not resources 
I have used in this book, they’re ones I do 
use occasionally and, as a designer, you can 
never have too much.

PixelSquid.com: The folks at TurboSquid 
.com have created a resource for 3D objects 
developed specifically for Photoshop. How-
ever, they do not use Photoshop 3D in the 
normal sense. You use a special plug-in to 
import the 3D objects into your Photoshop 
designs. You can control the angle of an 
object, but only in the plug-in window. As 
of this writing, this service is free but that 
may change. It’s an impressive resource.

DaFont.com: While Typekit is a robust and 
user-friendly font library, I will still go to 
Dafont.com for more stylized and unusual 
fonts. These fonts are free, but be aware of 
the usage rights for each font.

Archive3D.net: Photoshop’s ability to cre-
ate 3D objects and effects from scratch is 
really impressive, but you can also import 3D 
objects created in other applications. One 
resource I use is Archive3D.net. They have 
a lot of cool 3D models that you can import  
into Photoshop, and they are all free. Be 
warned though, they don’t always work 
when you import them into Photoshop. In 
most cases, they work fine but sometimes 
they come in exploded or missing parts. 
They can be adjusted, but sometimes they 
are just hopeless, but that’s the risk you take 
when it’s free.





Photo Effects
Little design is done these days without a photo being used at some 

point. Photos can be part of a design or can be the design themselves. 

In this chapter, we will explore a few ways to take your photos to the 

next level and turn even the most seemingly mundane shots into 

amazing design elements!
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Sketch Fade Effect

This is a really cool effect I have used for 
years. It’s really quite simple to achieve and 
can be used on almost any photo. I will 
often use this effect to make an otherwise 
dull photo a bit more interesting, or it can 
be used in a commercial sense as a back-
ground image for a product.

STEP ONE: Begin by pressing Command-O 
(PC: Ctrl-O) and opening the photo you 
want to apply the effect to (or just down-
load the photo I am using here from the 
book’s downloads page, mentioned in the 
book’s introduction). 

STEP TWO: Now, press Command-N (PC: 
Ctrl-N) and create a new document that is 
2000 pixels wide by 1300 pixels tall to build 
the final design in.

STEP THREE: Once the document is created, 
let’s add a light-colored texture to it. This 
will be the base texture the design will be 
built on. You can also use a simple solid col-
or if you like, as well. So, open the texture 
image (you can download this one from the 
book’s downloads page, too), use the Move 
tool (V) to drag-and-drop it into your new 
document, and then press Command-T 
(Ctrl-T) to activate Free Transform and scale 
it to fit. Press Return (PC: Enter) when done.

STEP FOUR: Now, let’s drag-and-drop the 
photo from Step One into this document. 
Activate Free Transform, again, and scale it 
to fit in the canvas area. Press Command-J 
(PC: Ctrl-J) to make a duplicate of the sub-
ject layer, then click on the duplicate’s Eye 
icon to turn it off for now. Reselect the 
original subject layer. 

STEP FIVE: Go under the Filter menu, under 
Stylize, and choose Find Edges. This will 
create an instant sketch look on the photo. 
You will see some color in the lines, so press 
Command-Shift-U (PC: Ctrl-Shift-U) to 
make it black and white. Now, open Levels 
by pressing Command-L (Ctrl-L) and adjust 
the highlights (white) and midtones (light 
gray) sliders (beneath the histogram) to 
force the background to white and reduce 
other light gray areas. Click OK.
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STEP SIX: In some cases, the lines may be 
thicker than you want them to be. To fix 
that, go under the Filter menu again, un-
der Other, and choose Maximum. Set the 
Radius to 0.5. Other images may require a 
higher setting, so you will have to experi-
ment a little. Choose Roundness from the 
Preserve pop-up menu and click OK.

STEP SEVEN: Change the layer’s blend mode 
to Multiply to hide the white area, and then 
drop its opacity to around 75%. Next, press 
Command-U (Ctrl-U) to open the Hue/
Saturation dialog. Turn on the Colorize 
checkbox, and then set the Hue slider to 
whatever color you’d like the lines to be. 
Here, I chose a light blue color by setting it 
to 191. Click OK.
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STEP EIGHT: Turn the duplicate layer at the top 
of the layer stack back on, and then select 
it. Go under the Filter menu, and choose 
Filter Gallery, and then under Texture, click 
on Grain. Again, the settings here will vary 
with different images, but for this one, I set  
the Grain Type to Speckle, the Intensity  
to 10, and the Contrast to 15. Click OK. 
(Note: To have all the Filter Gallery filters ap-
pear in the Filter menu, open Photoshop’s 
Preferences and, on the Plug-Ins tab, turn 
on the Show All Filter Gallery Groups and 
Names checkbox).

STEP NINE: Set this layer’s blend mode to 
Multiply, as well, then press-and-hold the 
Option (PC: Alt) key and click on the Add 
Layer Mask icon at the bottom of the Lay-
ers panel. This will add a black layer mask, 
which hides the entire layer.

STEP 10: Select the Brush tool (B) from the 
Toolbox, choose a simple, round, soft-
edged brush from the Brush Picker in the 
Options Bar, and then open the Brush panel 
(Window>Brush). Now, if you are using a 
pressure-sensitive tablet, click on Transfer 
on the left and set the Opacity Jitter and 
Flow Jitter Control pop-up menus to Pen 
Pressure. This allows you to reveal the im-
age based on how hard you press. If you do 
not have a pressure-sensitive tablet, then 
just set the brush Opacity to 50% in the 
Options Bar. Each stroke will build upon the 
next as you paint.
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STEP 11: Once the brush is set, press D to 
set your Foreground color to white, and 
then start painting on the layer mask in 
the area of the subjects you want to reveal. 
How much you reveal is up to you, but like 
I always say, don’t overdo it. 

Once it looks good to you, you can drop in 
some text (I used the font Futura Medium 
with a Stroke layer style) or a logo for a 
finished commercial look.

Final
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Stylized Light Effects

Here’s a cool light and color effect tech-
nique that adds a fantasy-like lighting look 
to a photo by taking a photo of a subject 
shot in a studio setting and blending them 
into an outdoor scene. 

STEP ONE: Begin by pressing Command-O 
(PC: Ctrl-O) and opening the image of the 
subject. As always, you can download the 
image we’re using here from the book’s 
downloads page, mentioned in the book’s 
introduction. (Note: I would recommend 
following along with the download files, 
so you get a better understanding of the 
technique. Then, experiment with other 
images afterwards.) We’ll need to extract 
the subject here, so get the Quick Selec-
tion tool (W) and paint over her to make 
an initial selection.

STEP TWO: Click on the Refine Edge button 
up in the Options Bar and, in the dialog, se-
lect the Refine Radius tool, and then make 
your brush Size a little larger than one of 
the subject’s eyes. Now, brush in the areas 
of her hair to include the rest of it. Do this 
to all the hair edges and any other edges 
that need to be selected. Also, boost the 
Contrast to around 15% to tighten up the 
selection around the softer edges. When 
you’re done, set the Output To pop-up 
menu to New Layer and click OK.

STEP THREE: Next, open the background im-
age. We’re using a rather ominous outdoor 
scene, here, which will make a cool back-
ground for the composite. The challenge is 
to make the studio-shot subject blend with 
this outdoor scene, but let’s modify the 
scene a bit first. Press Command-R (Ctrl-R) 
to reveal the Rulers, then click on the ver-
tical ruler on the left and drag a vertical 
guide to the center of the image. It should 
snap in place when you get close (if you 
have the Snap To Guides setting turned on 
in the View menu). 
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STEP FOUR: Make a duplicate of the Back-
ground layer by pressing Command-J (PC: 
Ctrl-J), then go under Edit menu, under 
Transform, and choose Flip Horizontal. Get 
the Rectangular Marquee tool (M) from the 
Toolbox and draw a selection over the left 
half of the image, then click on the Add 
Layer Mask icon at the bottom of the Layers 
panel to mask the unselected area. This cre-
ates an instant symmetrical image. You can 
get a different view by selecting the layer 
mask and pressing Command-I (PC: Ctrl-I) 
to Invert the values and thus revealing the 
other half of the image on each side (as  
I did here). It’s magic.

STEP SEVEN: With only the subject layer 
visible now, open the Channels panel 
(Window>Channels), press-and-hold the 
Command (PC: Ctrl) key, and click on the 
main RGB channel thumbnail to select the 
bright areas. Press Command-Shift-I (PC: 
Ctrl-Shift-I) to Inverse the selection, then 
press Command-J (PC: Ctrl-J) to copy the 
selected area to a new layer.

STEP EIGHT: Now, press Command-U (PC: 
Ctrl-U) to open the Hue/Saturation dialog. 
Turn on the Colorize checkbox, and then 
set the Hue to 220 and the Saturation to 
35. Click OK.

STEP FIVE: Once you decide which one you 
like, press-and-hold the Option (PC: Alt) 
key, and from the Layers panel’s flyout 
menu, choose Merge Visible to create a 
merged copy at the top of the layer stack.

STEP SIX: Now, using the Move tool (V) 
click-and-drag this new scene into the 
subject image, placing its layer below the 
extracted subject layer in the layer stack. 
Then, press Command-T (PC: Ctrl-T) to 
activate Free Transform and scale it to fit 
in the scene however you want it. When 
you’re done, click on this layer’s Eye icon  
to turn it off for the moment, and then 
select the extracted subject layer.
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STEP NINE: Set the layer’s blend mode to 
Multiply, then press Command-J (PC: 
Ctrl-J) to duplicate it. Drop the Opacity of 
this duplicate layer to 75%, and then turn 
the outdoor scene layer back on. You can 
also turn off the original Background layer 
(if it’s still on).

STEP 10: Select the original extracted subject 
layer, then press-and-hold the Command 
(PC: Ctrl) key and click on its thumbnail. 
Then, go under the Select menu, under 
Modify, and choose Contract. Set the 
amount to 10 pixels and click OK.

STEP 11: Press Command-Shift-I (PC: Ctrl-
Shift-I) to Inverse the selection, and then 
press Command-J (PC: Ctrl-J) to copy the 
edge selection to a new layer. Go under the 
Filter menu, under Blur, and choose Gauss-
ian Blur. Set the Radius to 10 pixels and 
click OK. Change the layer’s blend mode to 
Color Dodge, then press Command-J (PC: 
Ctrl-J) to create a duplicate to intensify the 
edge effect.

STEP 12: Command-click (PC: Ctrl-click) on 
the first edge layer to select both edge layers, 
and then press Command-G (PC: Ctrl-G) to 
put them in a group. Drop the group’s layer 
Opacity to 65%, and then move the group 
to the top of the layer stack.
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STEP 13: Command-click (PC: Ctrl-click) on 
the original extracted subject layer’s thumb-
nail to make another selection. Then, click 
on the Create a New Layer icon at the bot-
tom of the Layers panel to create a new 
blank layer, and move it below the subject 
layer. Press Shift-Delete (PC: Shift-Back-
space) to open the Fill dialog and change 
the Contents to White.

STEP 14: Press Command-D (PC: Ctrl-D) to 
Deselect, then go under Filter menu, under 
Blur, and choose Gaussian Blur, again. Set 
the Radius to 25 and click OK. Now, set the 
layer’s Opacity to around 80%.

STEP 15: Create another blank layer, move it 
to the top of the layer stack, and set its blend 
mode to Screen. Press D, then X, to set your 
Foreground color to white. Select the Gra-
dient tool (G) and, in the Options Bar, click 
on the gradient thumbnail and choose the 
Foreground to Transparent gradient. Also, 
click on the Radial Gradient icon (second 
icon to the right of the gradient thumbnail). 
Then, click-and-drag out a couple gradients 
on each side of the subject to create a light 
flare effect. 

STEP 16: Now, create one more blank layer, 
then click on the Linear Gradient icon in 
the Options Bar, set the gradient Opaci-
ty to 75%, and then press X to set your 
Foreground color to black. Click-and-drag a 
gradient from just below the bottom edge 
up a little ways to create a subtle fade.
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Final

STEP 17: Finally, select the background scene 
layer, then go under the Filter menu, under 
Blur, and choose Gaussian Blur, again. This 
time, set the Radius to 5 and click OK. This 
will create a depth-of-field effect. 
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Quick and Easy Double Exposure Effect

There are, of course, many ways to achieve 
a double exposure effect, as it has become 
quite a popular look these days. Here is a 
simple way to achieve that effect with some 
layer tricks. This is one of those techniques 
that once you have it figured out, you’ll try 
it on almost everything.

STEP ONE: Start by pressing Command-O (PC: 
Ctrl-O) and opening the image of the subject 
you want to use as the base shape for the ef-
fect. Here, we have a profile shot of a model 
on a simple background for easy extracting.

STEP TWO: Get the Quick Selection tool (W) 
and paint over the subject to select her. 
Then, click on the Refine Edge button, up in 
the Options Bar, and use the Refine Radius 
tool to adjust the selection around her hair 
and any other soft areas. Choose New Lay-
er from the Output To pop-up menu near 
the bottom of the dialog, then click OK.

STEP THREE: Now, press Command-N (PC: 
Ctrl-N) and create a new document mea-
suring 1400 pixels wide by 2000 pixels tall, 
with the Background Contents set to White. 
Use the Move tool (V) to drag-and-drop 
the extracted subject over onto this new 
document, and then press Command-T 
(PC: Ctrl-T) to activate Free Transform and 
scale and position it like I have it here. 
Press Return (PC: Enter) when done. Now, 
desaturate the subject by pressing Com-
mand-Shift-U (PC: Ctrl-Shift-U).

©
A

D
O

BE
 S

TO
CK

/P
A

FF
Y



74 Photoshop Tricks for Designers

STEP FOUR: Next, open the city street image. 
This is a cool one to blend with the subject 
for this double exposure effect because it 
has interesting negative space in the sky 
area, which will have a cool result in the 
final image. First, though, we need to 
change some things: Desaturate the image 
(like we just did with the subject), and then 
press Command-L (PC: Ctrl-L) to open Lev-
els. Click on the highlights (white) eyedrop-
per, beneath the Options button, and then 
click in the sky area to force it to white. 
Now, push the shadows (black) slider, be-
neath the histogram, to around 25 to boost 
the overall contrast. Click OK when done.

STEP FIVE: Press Command-A (PC: Ctrl-A)  
to select the entire image, then go un-
der the Edit menu, under Transform, and 
choose Flip Horizontal (I discovered that 
the blend worked better when I flipped  
it, so don’t be afraid to try that to get a 
different result you might like better). Now, 
drag-and-drop this image onto the main 
layout, and use Free Transform to scale and 
position it toward the top of the subject.

STEP SIX: With the city layer still selected, 
press Command-Option-G (PC: Ctrl-Alt-G) 
to clip it inside the subject layer below, and 
then click on the Add Layer Mask icon at the 
bottom of the Layers panel. Get the Gradi-
ent tool (G), click on the gradient thumbnail 
in the Options Bar, choose the Foreground 
to Transparent gradient, and then click on 
the Radial Gradient icon (the second icon to 
the right of the gradient thumbnail). With 
your Foreground color set to black, add a 
few gradients in the areas where you want 
to see the face of the subject. Don’t overdo 
it, though. 
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STEP SEVEN: Now, we’re going to blend one 
more image. I want to add this dead trees 
image to the bottom of the subject at the 
neck area. Again, start by removing the col-
or info by pressing Command-Shift-U (PC: 
Ctrl-Shift-U), then use Levels to force the 
sky to white (I pushed the shadows slider 
to around 60 this time).

STEP EIGHT: Open the Channels panel (Win-
dow>Channels), then press-and-hold the 
Command (PC: Ctrl) key and click on the 
RGB channel thumbnail to load the lumi-
nosity as a selection. Press Command-Shift-I 
(PC: Ctrl-Shift-I) to Inverse the selection to 
the trees. Finally, press Command-J (PC: 
Ctrl-J) to copy the selection to a new layer.

STEP NINE: Now, drag-and-drop this trees 
image into the main layout. Activate Free 
Transform, then Right-click and choose 
Rotate 180° to flip the layer upside down. 
Also, scale and position it down by the 
neck area of the subject. Right-click once 
again, and choose Warp from the pop-up 
menu. Use the control handles around the 
mesh to reshape the trees image to the 
contours of the neck shape. Press Return 
(PC: Enter) when done. Now, just add a 
layer mask to this layer, then get the Gra-
dient tool again, click on the Linear Gradi-
ent icon (the first icon to the right of the  
gradient thumbnail) in the Options Bar, 
and use the Foreground to Transparent 
gradient to fade the top edge of the trees 
layer to blend with the subject. I also add-
ed a layer mask to the subject layer and, 
with the Brush tool (B), used a low-opacity 
black brush to fade the bottom edge of  
her neck.
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STEP 10: Now we need to add a texture to 
the background. Here’s one that has good 
texture to it, but I don’t really care for the 
color. No problem. Just desaturate this 
texture (just like before), then bring it over 
onto the main image, placing it just above 
the Background layer in the layer stack, and 
drop the layer‘s Opacity to 50%.

STEP 13: With the trees layer still selected in 
the Layers panel, click on the Create New 
Adjustment Layer icon at the bottom of the 
panel and choose Gradient Map. Click on 
the gradient in the Properties panel to open 
the Gradient Editor. Then, click on the gear 
icon to the right of Presets and choose Pho-
tographic Toning from the flyout menu. Click 
OK in the dialog that appears, then choose 
the Cobalt-Iron 2 preset at the bottom of the 
presets, and click OK. 

At this point you are pretty much done short 
of any adjustments you want to make. For 
instance, I did a further Levels adjustment to 
the subject layer to help better match the 
contrast of the city image. As a final option, 
you can drop in some text (I used the font 
Futura Book), and you’re all set.

STEP 12: Now, select the main subject layer 
in the Layers panel and set the layer blend 
mode to Multiply. This will drop the white 
from the blended image and let the texture 
show through. Also, select the trees layer 
and drop the layer Opacity to 60%. 

STEP 11: Click on the Add a Layer Style 
icon at the bottom of the Layers panel 
and choose Gradient Overlay. Click on the 
Gradient thumbnail and choose the Fore-
ground to Background gradient, then set 
the Style to Radial. Set the Blend Mode to 
Linear Burn, the Opacity to 85%, and the 
Scale to 150%. Finally, turn on the Reverse 
checkbox and adjust the Angle slightly to 
give the background a subtle vignette ef-
fect. Click OK when done.
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FinalFinal
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Using Patterns to Blend Photos

This is an effect I saw over on Pinterest 
(lots of cool ideas floating around there). 
I loved the result and the elegance of the 
technique—so simple, yet so effective.

STEP ONE: Start by pressing Command-N (PC: 
Ctrl-N) and creating a new document that’s 
500 pixels by 500 pixels at 100 ppi, with the 
Background Contents set to White.

STEP TWO: Choose the Ellipse shape tool 
(press Shift-U until you have it) from the 
Toolbox and then, up in the Options Bar, 
set the Tool Mode to Shape, the Fill to 
black, and the Stroke to none. Press-and-
hold the Shift key, click on the upper-left 
corner, and drag to the lower-right corner 
to create a circle in the square (press-and-
hold the Spacebar as you drag to reposition 
the circle). You will want the edges of the 
circle to touch the edges of the canvas, if 
not extend beyond just a tiny bit. Once you 
have the shape drawn, click on the Eye icon 
to the left of the Background layer to turn it 
off, so you can see transparency.

STEP THREE: Go under the Edit menu and 
choose Define Pattern. Give the pattern a 
name and click OK.

STEP FOUR: Create another new document 
that’s 1500 pixels wide by 2000 pixels tall, 
with a white background. Click on the Cre-
ate a New Layer icon at the bottom of the 
Layers panel, and then press Shift-Delete 
(PC: Shift-Backspace) to open the Fill dialog. 
Choose 50% Gray from the Contents pop-
up menu and click OK.

STEP FIVE: Now, click on the Add a Lay-
er Style icon at the bottom of the Layers 
panel and choose Pattern Overlay. Click 
on the Pattern thumbnail and locate the 
circle pattern we just created (it should be 
the last one), then use the Scale setting to 
change the size of the pattern. Here, I set 
it to 35%. You can also move the pattern 
around manually by clicking directly on it in 
the image window and dragging it around 
to change its position. Click OK when done.
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STEP SIX: We now need to clip an image 
layer with the circle layer, but it won’t work 
right now because it would clip based on 
the gray fill and not the circles. So, first 
we need to get rid of the gray by simply 
dropping the layer Fill setting to 0%, near 
the top right of the Layers panel. Then, 
Right-click on the circle layer and choose 
Convert to Smart Object. This will maintain 
the transparency without having to raster-
ize the layer. (Note: The Fill setting will go 
back to 100% after you choose this.)

STEP SEVEN: Next, press Command-O (PC: 
Ctrl-O) and open the subject image you 
want to use. Here, we have a dancer on 
a white background (you can download 
this from the book’s companion webpage, 
mentioned in the book’s introduction). Drag-
and-drop the image into the working layout, 
and then press Command-T (PC: Ctrl-T) to 
activate Free Transform and position it in 
the composition. Press Return (PC: Enter) 
once it’s positioned, then press Command-J 
(Ctrl-J) to make a duplicate of this layer, and 
place one layer above and one below the 
pattern layer (as shown here).
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STEP EIGHT: Select the subject layer at the 
top of the layer stack, and then press Com-
mand-Option-G (PC: Ctrl-Option-G) to clip 
it to the pattern layer below.

STEP 10: Select the subject layer at the top 
of the layer stack again, and then click on 
the Create New Adjustment Layer icon at 
the bottom of the Layers panel and choose 
Gradient Map. Click on the gradient in 
the Properties panel to open the Gradient 
Editor. Then, click on the gear icon to the 
right of Presets and choose Photographic 
Toning (the same presets we used in the last 
technique) from the flyout menu. Click OK 
in the dialog that appears, then choose the 
Sepia-Cyan preset and click OK. 

STEP NINE: Now, select the other subject  
layer below the pattern layer and activate 
Free Transform, again. Move this layer to 
the left a little bit and then scale it up 
(press-and-hold the Shift key to keep it 
proportional), and you will see the effect 
take shape. Notice how I positioned this 
subject layer in relation to the one above 
the pattern layer. If using other images, the 
arrangement may take some trial and error. 
Press Return (PC: Enter), and then drop the 
layer’s Opacity to 75%.
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Finally, I added some text using the Eurostile 
ExtendedTwo font that I filled with white 
and blended by choosing the Difference 
layer blend mode, which makes the text 
dark on light backgrounds and light on 
dark backgrounds.

Final
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INDEX

3D effects, 16, 163
beveled text, 170
macro effects, 164
text, 16, 167
tricks, 16

3D Ground Plane 
turning off, 170

3D layers
converting to Smart Object, 17

3D menu, see specific menu options

3D Mode tools 
Drag, 168
Orbit, 17, 165
Pan, 165, 168
Slide, 16, 165

3D panel
Add New Light to Scene icon, 166
Current View settings, 16, 165
Environment options, 168, 171, 172, 174
Filter By: Lights icon, 166, 168
Front Bevel Material, 171
New Point Light, 166
Roughness setting, 171

3D Text, 167

50% Gray
filling with, 78, 98, 119, 129, 139, 148
90° Counter Clockwise adjustment, 96

A

Add a Layer Style icon, 2, 10, 38, 40, 46, 49, 54, 61, 
76, 84, 86, 98, 107, 120, 148, 153

Add Layer Mask icon, 3, 15, 31, 51, 57, 60, 66, 69,  
 74, 90, 94, 101, 147, 152, 154, 157, 158

Add Noise filter, 96

Adjustment layers
Black & White, 7
Hue/Saturation, 46, 57, 138, 159
Gradient Map, 76, 80, 124, 126
Levels, 125, 126, 138

Adobe Capture, 99

Adobe Photoshop CC Brushes, 99

Adobe Stock, 84

Adobe Typekit, 170

Artistic filter, 153

Average filter, 87

B

Background color
setting, 11, 71, 89, 96, 134, 145

Background Contents, 
setting the, 27, 30, 37, 78, 87, 118, 164

Background layer
duplicating the, 57
filling the, 126
turning off the, 26, 54, 64, 94, 

112, 118, 152

beveled text, 170

Blend If, 28, 61

blend modes
Color, 35
Color Burn, 47, 61
Color Dodge, 70
Difference, 9, 81, 125, 132, 148, 155
Hard Light, 59, 61, 86
Linear Burn, 76, 109, 152, 154
Linear Dodge (Add), 91, 117
Linear Light, 109
Multiply,  5, 45, 60, 66, 70, 76, 85, 88,  

90, 94, 107, 128, 135, 139
Normal, 147
Overlay, 5, 7, 12, 21, 23, 24, 27, 30, 33, 38, 40,  

49, 54, 55, 95, 106, 145, 153, 154, 160
Screen, 71, 98, 110, 112, 160, 173
Soft Light, 41, 125

blend photos, 20, 78

blend textures, 11

Blending Options, 27, 28, 61, 91

Blur filter, 50, 70, 87, 111, 160

bokeh effect, 106

book’s companion webpage, 12, 79, 114, 144,  
150, 156, 167, 170

book’s downloads page, 4, 6, 28, 56, 64, 68, 87,  
93, 100, 109, 118, 126, 135

brush effects
cinematic flare brush, 114
custom brush, 48
painting color using photos, 134
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Brush options panel
Brush Tip Shape, 3, 49, 101, 106, 134
Color Dynamics, 134
Pen Pressure, 119
Scattering, 106
Shape Dynamics, 3, 106, 119, 134, 152
Size Jitter Control, 119
Transfer, 66, 106, 124, 134

Brush Picker, 3, 24, 49, 66, 124, 152

Brush tool, 3, 11, 12, 24, 49, 66, 75, 101, 106, 
114, 116, 119, 124, 134, 152, 160

brushes
defining, 48, 114, 134
saving, 108
downloading, 11

Brushes library, 99

Brushes list, 99

C

channels
inverting, 24
loading as selection, 33, 94, 112
making a duplicate of, 24
return to color image with, 25

Channels panel, 12, 30, 33, 51, 53, 94,  
100, 112, 127, 144, 150

Character panel
adjusting text in the, 2, 27

clipping mask, 15, 38, 74, 80, 119, 139, 146

color blend effect, 134

color effects, 123

Color Picker, 7, 8, 48, 107, 130, 135, 164

Colorize checkbox, 65, 69

commercial effects, 129

compositing, 87, 136, 114

Convert to Smart Object, 17, 79

copy to clipboard, 172

Create a New Layer icon, 7, 26, 37, 48, 49, 54,  
78, 84, 98, 101, 106, 114, 119, 127,  

135, 138, 148, 154, 160, 165

Create New Adjustment Layer icon, 57, 76, 80,  
95, 102, 138, 147, 159, 174

Create New Channel icon, 150

create new document, 6, 10, 25, 30, 37, 48, 54,  
 59, 64, 73, 78, 84, 87, 96, 106, 126,  
 129, 136, 145, 151, 156, 164

Create New Tool Preset icon, 108, 135

Creative Cloud, 99

Custom Shape tool, 109

D

Define Brush Preset, 48, 114, 134

Define Pattern, 2, 10, 20, 26, 37, 54, 78, 97

defining a texture, 37

Defringe, 89, 132, 144, 158

desaturate
command, 35, 37, 64, 73, 75, 137, 146

deselect
command, 31, 71, 100, 127, 154, 156

design elements, 118

Direct Selection tool, 22, 131

Distort filter, 116

double exposure effect, 73

duotone effect, 126

duplicate image, 139

duplicate, layer or selection
command, 69, 79, 87, 90, 156, 157, 167, 173

E

Edge Detection Radius slider, 136

Edit menu, see specific menu options

Ellipse shape tool, 78

Elliptical Marquee tool
making ovals with the, 154

Eraser tool, 112

Expand
selection, 14

extracting
subject from background, 24

Eye icon, 64, 69, 78, 94, 112, 118, 144, 152

Eyedropper tool, 60, 140
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INDEX

F

fade, 31

File menu, see specific menu options

Fill 
dialog, 12, 24, 27, 30, 33, 50, 71, 119, 139
layer or selection, 48, 84, 101, 127, 156
opacity, 98
open command,  27, 37, 78, 129, 148, 154, 156

Filter Gallery, 59, 66, 153

Filter menu, see specific menu options

Find Edges filter, 64

flares, 116

Flatten Image, 139, 173

Flip Horizontal, 34, 74, 118, 132

Flip Vertical, 158

Foreground and Background colors
setting to defaults, 89, 96, 100, 124, 134

Foreground color
setting, 11, 30, 48, 49, 58, 60, 67, 71, 74, 95, 101, 

107, 116, 126, 135, 140, 145, 152, 158

FOV (Field of View) setting, 165

Free Transform
activating,  6, 23, 27, 30, 31, 38, 45, 46,  

 51, 54, 59, 87, 93, 102, 110,  
 118, 127, 130, 137, 154, 158

flip horizontal using, 34, 74, 118
resizing and scaling with, 6, 23, 64, 69, 73, 79,  
 89, 94, 145, 151, 154, 156
scaling and rotating with, 90

G

Gaussian Blur filter, 50, 70, 96, 111, 141, 160

Google, 114

Gradient Editor, 76, 80

Gradient Map
removing color with, 53, 89, 100, 126, 134

Gradient Picker,  5, 28, 31, 50, 58, 60, 74, 90, 95, 
138, 145

Gradient tool, 28, 31, 35, 50, 58, 61, 71, 74,  
 90, 95, 138, 147, 158, 159

gradients
Black, White, 41
Foreground to Background, 5
Foreground to Transparent, 58, 74, 95, 138,  

140, 145, 158, 160
linear, 71, 138, 158
radial, 28, 31, 50, 58, 74, 91, 95, 140, 145

Grain filter, 35, 59, 66

graphic effects, 43

grouping layers, 10, 70

grunge style effects, 150

guides, 129, 156

H

HDR Toning adjustment, 139

High Pass filter, 6

highlights (white) eyedropper, 93

Hollywood effects, 30, 136, 143

Horizontal Type tool, 2, 8, 10, 14, 16, 22, 27, 35, 41,  
47, 52, 55, 58, 60, 86, 91, 95, 128, 133, 164, 167

HUD graphic elements, 53, 148

Hue/Saturation
adjustment, 35, 46, 60, 90, 102, 140, 159
open command, 65, 69, 153

I

IBL (Image Based Light), 166, 168, 171

Image menu, see specific menu options

Image Rotation, 87

Infinite Light, 174

Input Levels, 45, 94, 96, 100

Inverse, 69, 75, 131, 144

Invert, 13, 24, 30, 51, 69, 88, 100, 114, 146, 150, 157

iPhone, 128

J

Jurassic World movie, 2
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L

Lasso tool, 34

layer masks
add, 3, 15, 31, 51, 57, 60, 66, 69, 74, 90,  

94, 101, 147, 152, 154, 157, 158
add black (Hide All), 33, 57, 152
inverting, 13

Layer menu, see specific menu options

Layer Style dialog, 2, 3, 5, 9, 21
Advanced Blending section, 55
Blend If options, 46, 86, 91
Pattern Picker, 84
Reverse checkbox, 76
Underlying Layer slider, 91
using the, 2

layer styles
add, 2, 10, 38, 40, 46, 49, 54, 61, 76,  

84, 86, 98, 107, 120, 148, 153
Bevel & Emboss, 11, 22
Blending Options, 27, 55, 86, 148, 154
Color Overlay, 5
Drop Shadow, 5, 9, 22, 41, 109, 128
Gradient Overlay, 5, 40, 49, 76, 85, 120
Outer Glow, 109, 114, 117, 120
Pattern Overlay, 2, 10, 21, 27, 38, 54,  

61, 84, 98, 148
Stroke, 55, 107

layers
blending options, 46
clipping, 15, 38, 74, 80, 119, 139, 146
convert to Smart Object, 17, 79
create new, 4, 7, 10, 26, 30, 37, 48, 54,  

61, 78, 84, 98, 101, 106, 114, 119,  
127, 135, 138, 148, 154, 160, 165

create new below, 101
drag-and-drop, 27, 45, 93, 110
duplicating, 64, 69, 79, 87, 90, 157, 167, 173
fill with 50% gray, 54
grouping, 10, 70
load as a selection, 15
merge down, 167
merge visible, 34, 69, 144
shape, 20, 21, 22, 23, 39, 56, 129
unlock, 97

Levels adjustment, 13, 46, 53, 64, 74, 75, 93, 96,  
100, 114, 125, 126, 133, 138 150

Levels dialog
highlights (white) eyedropper, 93
Input Levels sliders, 45, 93, 94, 96, 97, 100

Libraries panel, 99

light effects, 105

light flare, 114, 140

light rings, 114

light streak effect, 118

Line tool, 26

Linear Gradient icon, 71, 138, 158

lines, drawing, 26

Link icon, 51

Load Selection, 13, 25

Lock icon, 97

Lock Transparent Pixels icon, 145, 160

Lorem Ipsum, 164

luminosity, 75, 94

M

macro effects, 3D, 164

Magic Wand tool, 136, 158

Matting, 89, 112, 144, 158

Maximum filter, 65

Merge Visible, 34, 69, 144

motion blur effect, 112

Move to View icon, 166, 168, 174

Move tool, 6, 13, 17, 27, 30, 31, 33, 38, 41, 45,  
 50, 59, 64, 73, 87, 93, 102, 110, 118,  
 127, 132, 137, 157, 159, 165, 167

movie posters, 136

N

New
document, 6, 10, 25, 30, 37, 48, 54, 59, 64,  
 73, 78, 84, 87, 96, 106, 116, 118,  
 126, 129, 136, 145, 151, 156, 164

New 3D Extrusion from Selected Layer, 167, 170

New Guide Layout, 8, 37

New Mesh from Layer, 16, 165, 167

New Point Light, 166
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INDEX

O

Offset filter, 84, 97

Open
image,  6, 10, 12, 20, 54, 56, 59, 64, 68,  
 73, 79, 87, 131, 151, 156, 167, 170

Options Bar, 3, 8

Output To menu, 73, 136

P

paint, 114

painted color effects, 134

panels, see specific panels

paste command, 172

Paste Lorem Ipsum, 164

Patch tool, 97

Path Operations icon, 20, 26, 39

Path Selection tool, 39, 120

paths,
transform, 22, 39, 40

Paths panel, 56, 119, 120

Pattern Picker, 21, 27, 38, 61

Pen Pressure, 3, 66

Pen tool
creating path with the, 119

photo effects, 63

Photographic Toning presets, 76, 80

Photoshop, 99

Photoshop Libraries panel, 99

Pinterest, 78

Polar Coordinates filter, 116

Polygon tool, 48

Postcard, 165, 167

Poster Edges filter, 153

pressure-sensitive tablet, 66

Properties panel, 3D
camera setting for FOV, 16
Cap settings, 171
Edit Texture, 172
Edit UV Properties, 173
Extrusion Depth, 170

Ground Plane section, 171
IBL (Image Based Light) checkbox, 166
IBL Intensity slider, 168
Infinite Light, 174
Move to View icon, 166, 168, 174
New Texture, 172, 173
Point, 168, 174
Reflection, 171
Shine, 171

Puppet Warp, 110

Q

Quick Mask
mode, 50
options, 49

Quick Selection tool, 14, 56, 68, 73, 88, 131

R

Radial Gradient icon, 28, 39, 50, 74, 91, 95, 140

Rectangle tool, 20, 39, 56, 129

Rectangular Marquee tool, 37, 69, 119, 156, 159

Refine Edge
dialog, 13, 14, 25, 68, 73, 89, 131, 136
Edge Detection Radius, 136
Output To menu, 73, 136

Refine Radius tool, 73, 68, 131, 136

Remove Black Matte, 112

removing color, 30, 35, 37, 44, 50, 53, 
59, 114, 118, 132, 173

Render 3D Layer, 17, 166, 174

reveal color, 124

Reverse checkbox, 5, 41, 76

rotate image 180°, 75

rulers, 25, 68, 129, 156

S

Save, 25

Select All
command, 26, 108, 172

select image command, 74

Select menu, see specific menu options
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selections
add areas to, 136
click-and-drag out, 37
copy to a new layer, 13, 25, 53, 70, 112,  

118, 144, 151, 158, 159
duplicate, 167, 173
expand, 14
fill, 30, 33
inverse, 131, 136
load, 13, 25
load channel as, 112
load image brightness as, 100
load light areas as, 53, 127
load luminosity as, 75, 94
load shape as, 30

shape
layers, 20, 21, 22, 23, 30, 39, 56, 129
subtract from existing, 40

Shape Dynamics, 3, 106, 119, 134

shape tools, 48

Show, 170

Show Mesh checkbox, 110

silhouettes, 144

Simulate Pressure checkbox, 119

Skew, 22, 27, 39, 120, 130

Smart Objects
convert to, 17, 79

smart phone, 99

Snap, 130

Snap To Guides, 68

spark elements, 109

sports-ad-inspired effect, 20

stroke, 20, 26

stroke path, 119, 120

Stylize filter, 64

T

text
adjust tracking and leading, 27
beveled, 170
duplicate layer, 23
set layer, 14, 16, 27

text effects
stone age, 2

texture effects, 83

Texture filter, 35, 66

tool modes, 12, 48, 56, 78, 129

tool preset, 108, 135

tools, see specific tools

Transform, 22, 23, 27, 28, 30, 31, 
34, 38, 39, 40, 112, 120

Trash icon, 97

type effects, 1

U

Underlying Layer slider, 91

unlock layer, 97

V

vector elements, 37

View menu, see specific menu options

vignette effect, 76

W

Warp
grid, 112
remove pin, 110
transform using, 34, 40, 75, 112
vector path, 40

Wind filter, 96



This is your friendly reminder from the world around you. You can make something 
today that didn’t exist yesterday. You can try something that’s never been done before

or just try something that you’ve never done before. But just doing something is the 
first step towards doing something great. Fuel your creativity.

Easy online training from the best in Photoshop, Lightroom & Photography                     kelbyone.com
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